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DIGITAL IMAGE EDITING  
Made Simple   

with 
 Photoshop Elements 9.0 

MacMania 11 
February 06, 2011 

Thomas B. Grollman  

Sources for Presentation 

•  My own experience as an enthusiastic 
digital imaging hobbyist 

•  Numerous Seminars 
•  Books: 

– Kelby, “Photoshop Elements 9 Book…” 
–   Brundage “Photoshop Elements 9– The 

Missing Manual” 
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INTRODUCTION 
•  Photoshop is the digital imaging “Killer App” 

–  It has transcended to the point of becoming a verb in the 
English language. 

•  It was born around 1990.  

•  Has matured with the demands of the maturing digital 
hardware evolution. 

•  It has given total control of image production from 
image capture to output to the consumer. 

12/24/10 Thomas B. Grollman, MD 6 

History 
•  Written by Tom Knoll with the support of his brother 

John in the late 1980’s. 
•  Photoshop v. 1.0 was first shipped in Feb, 1990. 
•  An upgrade has appeared approximately q 18 

months ever since.  
•  CS 5 (v. 12) was released Apr, 2010 ($699 from 

Adobe). 
•  Originally written for the Mac. Windows version 

became available with v. 2.5 in 1992. Palettes were 
also introduced with this version. 

•  Layers were introduced with v. 3.0 in 1994. 

12/24/10 Thomas B. Grollman, MD 7 

Pared-Down Photoshop 
Versions 

•  Photoshop Elements 2.0 – 8.0 (prior releases) 
–  Mac and Windows versions. 

•  Photoshop Elements 9.0 released Sept. ‘10 
–   Windows and Mac versions released in  the same 

box. 
–  Has somewhere between 50 - 75% of the 

capabilities of the senior program at less than 
1/6th the price. 

•  Does not have such things as pen tool, channels, LAB/
CMYK modes among others 

Photoshop Elements 9 

•  Editing tools include 
–  NEW TO PSE 9: Layer masks, Content Aware 

spot healing brush 
–  Other features include Photomerge Exposures 

(mini HDR), Scene cleaner, Recompose photos 
(content aware scaling), Lens distortion correction 

–  Many other features with improved interface 
–  $79 (after $20 mail-in rebate) from Adobe.com 
–  $59 Windows/Mac version at MacMall.com with 

rebate 
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Mac vs. Windows 
•  In the past, Adobe products for Mac and 

Windows were very similar. 

•  Versions PSE 5 – 8 had major differences 
between Mac and Window versions, 
particularly in photo organization 

•  PSE 9 brings the 2 platforms back together 

Mac vs. Windows (cont) 

•  The program works similarly for each 
platform: 

  Mac    Windows 
  command key  control key 
  option key   alt key 
  return   enter 
  delete   backspace 
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Elements 9.0 vs. 
Photoshop CS5 

•  Elements much less expensive 
•  Elements is focused for the home user 

and/or non-professional 
– Elements works only in RGB mode (not 

CMYK  mode needed for commercial 
printing) 

– Elements lacks Commercial art tools (Pen 
tool, Channels, etc.) 
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Partial List of PS CS5 Features 
Not Found in PS Elements 
•    CHANNELS PANEL 
•    PEN TOOL 
•    LAYER COMPS 
•    PATHS PANEL 
•    CMYK & LAB MODES 
•    HDR 
•    VANISHING POINT 
•    TEXT ON A PATH 
•    COLOR BALANCE ADJUSTMENT 
•    WEB PAGE SLICING 

FULL 16 BIT EDITING 
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How to learn Elements 

•  Although pared down, Elements is still a 
very complex program 
– Has more features than you are likely ever 

to learn or use. 
•  Has easier to use simplified editing 

modes (Quick Fix and Guided) 
•  Focus on what you want to accomplish 
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How to learn Elements (cont) 
•  Use sources that help you learn best 

– Books: Kelby, “Photoshop Elements 9 
Book…”; Brundage “Photshop Elements 9 
– The Missing Manual” 

– Classes and Seminars (KCC, Photoshop 
World) 

– Use the program frequently 
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How to learn Elements (cont) 

– Video Tutorials: CD’s, DVD’s, Internet 

• www.lynda.com 
– Monthly subscription $25 

• www.photoshopelementsuser
.com/learningcenter/ 

– Yearly subscription $59 (includes 
online tutorials, magazine, etc.) 
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3 Programs in 1 

•  PS Elements comes with 3 
interconnected programs 
– PS Elements 9 editing program 

•  Divided into 3 (Guided, Quick, and Full Edit) 

– Organizer  
– Camera Raw (non-destructive editor for 

Raw files) 
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Guided Edit Anatomy Quick Edit Anatomy 
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Full Edit Anatomy Organizer 
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EXPOSURE 

•  Check your picture’s histogram 
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EXPOSURE 

•  Overexposed Histogram - blown-out 
highlights 
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EXPOSURE 

•  Underexposed Histogram - too dark 
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PS Elements 9.0 Editing Demo 
•  PS Elements 9.0 used for Demo 

•  Goal of this presentation is to provide 
you with a platform upon which you 
can build. 

–  IMPOSSIBLE TO LEARN PROGRAM IN JUST  
3 HOURS 

–  THERE IS VALUE IN REALIZING WHAT CAN 
BE DONE 



EDITING PICTURES WITH PSE 9.0 – NOTES 
Thomas Grollman, MD 12/24/10 
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Some General Principles I use when editing. 
 
Never edit an original image. Always have the original backed up elsewhere 
(preferably at least twice). 
 
Use layers in making your edits. I usually make a copy of the background 
layer to work on. I can easily correct a mistake that way (although there are 
many other ways to do this). Also using a layer for different edits and saved 
in a layers format (PSD, TIFF), makes further editing of the image easier 
when you come back after having closed the image. 
 
When finished with editing an image , do a Save As rather than just a Save 
to prevent possibly throwing away an original image. 
 
Sharpening: Almost all digital photos need extra sharpening out of the 
camera. Generally, sharpening should be the last thing you do to the picture 
before final output. Other maneuvers (such as color corrections, etc.) will 
tend to reduce the sharpening you have done earlier. Check your sharpening 
at 100% magnification (just double click on the zoom tool in the toolbox). If 
you see halos, it is probably over-sharpened. However, some over-
sharpening is recommended for printing output, but not for images to be 
shown on the web. 
 
As you become more skilled, start using the keyboard shortcuts. It will 
save you time. 
 
Undo: Many ways to step backwards: Keyboard commands (cmd Z), 
Edit>Undo, Undo History Palette. However, once you close your image you 
lose the Undo History. 
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GUIDED EDIT - The starting point if you are a “Newbie”. It provides a step 
by step guide for some of the most common edits for an image. 

• Notes not necessary as GUIDED EDITED has notes to guide you 
with every step. 

 
BASIC PHOTO EDITS 

• CROP 
• RECOMPOSE (CONTENT AWARE SCALING) 
• STRAIGHTEN/ROTATE 
• SHARPEN 

o BEST DONE AT 100% 
§ Double click on magnifying glass tool 

o THE LAST THING TO DO 
LIGHTING AND EXPOSURE (TONAL CORRECTION}  

• LIGHTEN OR DARKEN 
• BRIGHTNESS & CONTRAST 
• LEVELS ADJUSTMENT 

COLOR CORRECTION 
• ENHANCE COLORS 
• REMOVE COLOR CAST 
• CORRECT SKIN TONE 

OTHER GUIDED EDIT FIXES 
• TOUCH UP (CORRECT BLEMISHES, SCRATCHES, ETC.) 
• FIX KEYSTONE (LENS) DISTORTION 
• OVERALL GUIDE FOR EDITING PHOTOS 

PHOTOMERGE 
• GROUP SHOT 
• FACES 
• SCENE CLEANER 
• EXPOSURE (POOR MAN’S HDR) 
• STYLE MATCH 

AUTOMATED ACTIONS – NOT TOO USEFUL 
PHTOGRAPHIC EFFECTS 

• LINE DRAWING 
• MAKE OLD FASHION PHOTO 
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• SATURATED SLIDE FILM EFFECT 
FUN EDITS 

• OUT OF BOUNDS 
• PERFECT PORTRAIT 

o FACIAL RETOUCHING WORKFLOW 
• POP ART 
• REFLECTION 

 
QUICK EDIT - The Quick mode is where beginners will do most of their 
work. 
 

• GENERAL 
o USES INTUITIVE SLIDERS FOR CONTROLS 
o CAN TRY AUTO FIRST  

§ IF RESULT NOT SATISFACTORY CLICK UNDO OR RESET 
ú UNDO BUTTON TAKES YOU BACK ONE STEP AT A 

TIME 
ú RESET BUTTON TAKES YOU ALL THE WAY BACK 

TO ORIGINAL 
o TO THE RIGHT OF EACH SLIDER IS A SMALL ARROW 

§ CLICK ON THE ARROW TO SEE PREVIEWS OF SLIDER 
USE 

§ HOVER OVER EACH PREVIEW TO SEE PROSPECTIVE 
RESULT 

• SMART FIX – AUTO OR SLIDER 
o QUICK WAY TO LET COMPUTER TRY A FIX 

• LIGHTING (TONAL CORRECTIONS) 
o TRY AUTO FIRST 

§ LEVELS AUTO MAY INVOLVE SOME COLOR CHANGES AS 
WELL AS TONAL (LUMINOSITY) CHANGES 

§ CONTRAST AUTO WILL AFFECT JUST LUMINOSITY 
o SHADOWS AND HIGHLIGHTS SLIDERS PLUS MIDTONE 

§ MIDTONE SLIDER IS A MID-CONTRAST SLIDER 
SOMETIMES KNOW AS CLARITY (APPEARS TO SHARPEN 
IMAGE) 
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ú CAN MAKE YOUR PHOTO P “POP” 
• COLOR 

o SATURATION & HUE SLIDERS 
§ CAN SELECTIVELY CHANGE HUE (COLOR) BY MAKING A 

SELECTION WITH THE QUICK SELECTION TOOL IN THE 
TOOL BOX ON THE LEFT 

ú CAN REFINE SELECTION BY ADDING OR 
SUBTRACTING BY CLICKING THE THE ADD OR 
SUBTRACT SIGNS IN THE OPTION BAR  

ú DESELECT BY EITHER SELECTING DESELECT 
(MENU>SELECT>DESELECT OR CTL/CMD D) 

o BALANCE SLIDERS 
§ TEMPERATURE AND TINT SLIDERS GOOD FOR COLOR 

CASTS 
• SHARPENING ALWAYS LAST FIX 

o OK TO OVERSHARPEN A LITTLE FOR PRINT, BUT NOT FOR 
WEB 

• TOOL BOX IS ON THE LEFT 
o TOOLS INCLUDE:  

§ ZOOM, HAND (MOVE), CROP 
§ SELECTION TOOLS (QUICK SELECTION, RED EYE, 

WHITENING (TOOTH BRUSH), BLUE SKIES (PAINT 
BRUSH), BLACK&WHITE 

 
FULL EDIT - Where the real power of PS is. 
 

• TOOL BOX IS ON THE LEFT 
 

• OPTION BAR IS JUST ABOVE THE IMAGE PANEL 
o OPTION CHOICES CHANGE ACCORDING TO THE TOOL 

CHOSEN 
 

• PANELS BIN IS ON THE RIGHT 
o THE WORKSPACE WITH PANELS ORGANIZATION IS ENTIRELY 

ADJUSTABLE 
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o CHOOSE YOUR PREFERRED PANELS FROM THE LIST FOUND 
UNDER THE MENU>WINDOW AT THE TOP OF YOUR SCREEN 

o Note: I personally prefer the Histogram, Undo History, and 
Layer panels to be open for my default working space. Under 
MENU>PHOTOSHOP ELEMENTS>Preferences>General, I have 
Save Palette Locations checked off. 

 
• AT THE BOTTOM, IS YOUR IMAGE BIN, WHERE YOU CAN SEE 

THUMBNAILS OF YOUR OPEN IMAGES 
 

• LAYERS PANEL 
o LAYER CONCEPT EXPLAINED 
o DEMO ON HOW LAYERS MAY BE USED 
o LAYER MASKS IS AN ADVANCED FEATURE NEW TO PSE 9.0, 

TO MY MIND, THIS IS THE BIGGEST IMPROVEMENT OF THIS 
NEW VERSION. 

§ LAYER MASKS DEMO  
§ Working on a portrait (in full edit mode): 
§ Say you want to soften the skin but leave the eyes, 

nose, mouth sharp. 
§ DUPLICATE THE BACKGROUND. (CMD J, OR 

Menu>Layer>New>Layer Via Copy, Drag Background 
Layer (Or Layer 1) to bottom left Create New Layer Icon  

§ SURFACE BLUR the Background copy : select 
Background Copy layer (or Layer 1). 
Menu>Filter>Blur>Surface blur. 

§ SELECT BACKGROUND LAYER. Click on LAYER MASK 
icon (looks like a camera, second icon from left at 
bottom).  

§ Select the white box on the right in the Background 
Copy layer. Select the Brush tool from the Toolbox. 
Make sure your foreground color is Black at the bottom 
of the Toolbox. 
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§ Paint with the black brush tool over areas on the 
portrait you wish to bring back in focus (eyes, lips, 
teeth, hair, etc.) 

ú Remember: Black conceals, White reveals 
§ Congratulations! You now know how to make a layer 

mask. 
 

• CROPPING, STRAIGHTENING, RECOMPOSE 
o FOR MULTIPLE OR SINGLE SCANNED PHOTOS  

§ MENU>IMAGE>DIVIDE SCANNED PHOTOS 
o STRAIGHTEN HORIZON 

§ SELECT STRAIGHTEN TOOL>DRAW LINE ON HORIZON 
§ RECOMPOSE (CONTENT AWARE SCALING) 

 
• TONAL ADJUSTMENTS 

o LIGHTENING THE IMAGE 
§ MANY WAYS USING MENU>ENHANCE (select one of 

several choices) 
§  OR LAYERS PANEL>ADJUSTMENT LAYERS (Click on 

adjustment layer icon (looks like a prohibition sign third 
icon from left at bottom). Select Levels or 
Brightness/Contrast from the pop-up. 

o LIGHTENING SHADOWS 
§ MENU>ENHANCE >ADJUST 

LIGHTING>SHADOWS/HIGHLIGHTS 
 

• COLOR ADJUSTMENTS 
o COLOR CAST CORRECTION 

§ MANY WAYS USING MENU>ENHANCE (select one of 
several choices) 

§  OR LAYERS PALETTE>ADJUSTMENT LAYERS (Click on 
adjustment layer icon - looks like a prohibition 
sign)>SELECT ONE OF SEVERAL CHOICES 

o MAKE GREEN APPLE INTO RED APPLES 
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§ LAYERS PALETTE>ADJUSTMENT LAYERS (Click on 
adjustment layer icon - looks like a prohibition 
sign)>SELECT HUE/SATURATION>CHANGE MASTER 
POPUP TO GREEN> WITH EYEDROPPER CLICK ON A 
GREEN APPLE>SLIDE HUE SLIDER TO LEFT UNTIL 
APPLES TURN RED> Select the white box on the right in 
the HUE/SATURATION adjustment layer layer. Select 
the Brush tool from the Toolbox. Make sure your 
foreground color is Black at the bottom of the Toolbox. 

§ Paint with the black brush tool over areas on the 
portrait you wish to bring back the green color 

 
• SELCTIONS 

o TWO TYPES:  
§ MANUAL 

ú MARQUEE, LASSO, LAYER MASKING, , SELECTION 
BRUSH TOOL 

§ AUTOMATIC 
ú QUICK SELECTION TOOL THE BEST 
ú OTHER METHODS INCLUDE MAGIC WAND TOOL,  

§ SAVE SELECTIONS – MENU>SELECT>SAVE SELECTION 
ú FILE SHOULD THEN BE SAVED AS PHOTOSHOP 

FILE (PSD not JPG) 
ú SELECTIONS CAN THEN BE RECALLED BY 

MENU>SELECT>LOAD SELECTION 
§ SELECTION USES 

ú COLOR, TONAL CHANGES, IMAGE 
MANIPULATIONS 

•  
• BODY SCULPTING 

o REMOVE LOVE HANDLES 
§ MENU>FILTERS>DISTORT>LIQUIFY>SHIFT PIXEL 

TOOL (7th tool down in toolbox on left of the Liquify 
panel)>REMOVE LOVE HANDLES 

•  
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• REMOVE OBJECTS 
o SPOT HEALING BRUSH AND HEALING BRUSH TOOL 

§ SPOT HEALING BRUSH NOW HAS A CONTENT AWARE 
OPTION MAKING REMOVAL OF SMALL OBJECTS VERY 
EASY 

ú Particularly useful for removal of telephone lines 
ú SHIFT CLICK FOR STRAIGHT LINES (TELEPHONE 

LINES) TO SPEED REMOVAL 
o CLONE STAMP TOOL (OPT CLICK TO SELECT SOURCE FROM 

IMAGE TO BE CLONED) 
§ CHANGE SOURCE FREQUENTLY TO AVOID PATTERNS 

REVEALING SLOPPY IMAGE EDITING    
•  
• REFLECTIONS 

o RECTANGULAR MARQUEE TOOL TO SELECT OBJECT FOR 
REFLECTION>CMD J>MENU>IMAGE>ROTATE>FLIP 
SELECTION VERTICAL>SELECT MOVE TOOL>MOVE FLIPPED 
IMAGE ON LAYER 1 DOWN OVER WATER>ADJUST LAYER 1 
OPACITY DOWN 

o Further realistic adjustments can include blurring of layer 1 
along with gradient layer mask of layer 1. 

 
• RETOUCHING 

o TIPS:  
o WORK ON SEPARATE LAYERS SO OPACITY CAN BE ADJUSTED 

TO BE MORE REALISTIC 
o USE SPOT HEALING BRUSH AND HEALING BRUSH TOOLS, 

CLONE STAMP TOOL, GAUSSIAN BLUR WITH LAYER MASK 
 

• LENS DISTORTION 
o MENU>FILTER>CORRECT CAMERA DISTORTION>ADJUST 

SLIDERS 
o ANOTHER WAY: MENU>EDIT>IMAGE>TRANSFORM>FREE 

TRANSFORM>MAKE ADJUSTMENTS BY CMD CLICK ON THE 
HANDLES 
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• PANORAMAS 

o OPEN PANORAMA IMAGES 
>MENU>FILE>NEW>PHOTOMERGE© PANORAMA>CLICK ADD 
OPEN FILES (USE DEFAULT LAYOUT AUTO FIRST)>CLICK OK 

 
• RED EYE 

o MANY WAYS: RED EYE TOOL,  
o OR MAKE SELECTION OF EYES>CMD/CTL J (TO PUT 

SELECTION ON SEPARATE LAYER)>SELCT COLOR (DOUBLE 
CLICK ON FOREGROUND COLOR & MAKE COLOR 
CHOICE)>CMD/CTLCLICK ON LAYER 1 ICON TO RESELCT 
EYES>MENU>EDIT>FILL LAYER>ADJUST OPACITY OF LAYER 
1 TO LIKING  

o OR CMD/CTL DELETE TO FILL SELECTION WITH FOREGD 
COLOR>ADJUST LAYER BLEND MODE FROM NORMAL TO 
COLOR 

 
• TYPE AND CLIPPING MASK 

o OPEN A BACKGROUND THAT YOU WANT TO TYPE ON 
o TOOL BOX>TYPE TOOL 
o TYPE YOUR WORD(S) WHICH AUTOMATICALLY GOES ON A 

SEPARATE LAYER 
o PRESS ENTER (or click Move tool)TO RASTERIZE THE TYPE 
o CHOOSE MOVE TOOL 
o RESIZE AND MOVE YOUR TYPE TO YOUR DESIRED POSITION 
o PRESS ENTER 
o CHOOSE TYPE TOOL>SELECT YOUR TYPED WORD>CHOOSE 

FONT, WARP, COLOR IN OPTION BAR 
o TO MAKE CLIPPING MASK 
o SELECT BACKGROUND LAYER>CMD A>CMD SHIFT J>MOVE 

TYPE LAYER BELOW LAYER 1>SELECT LAYER 
1>MENU>LAYER>CREATE CLIPPING MASK 

o CHANGE COLOR OF THE NEW BACKGROUND LAYER TO YOUR 
CHOICE 



10	  

	  

o DOUBLE CLICK ON FOREGROUND COLOR>SELECT 
COLOR>OPT/ALT DELTETE 

 
• BLUE SKIES 

o GOAL IS TO CHANGE THE GREY SKY OF YOUR IMAGE TO 
BLUE SKIES TAKEN FROM ANOTHER IMAGE 

o OPEN YOUR 2 IMAGES 
o SELCT THE GREY SKY IMAGE>SELECT MAGIC WAND 

TOOL>CLICK ON THE SKY>SHFT CLICK UNTIL ALL SKY IS 
CHOSEN (MAY NEED TO UNCLICK CONTINOUS IN THE 
OPTION BAR)> DELETE NON-SKY SELECTION (CAN USE 
MARQUEE OR QUICK SELECTION TOOL WITH OPT KEY) 

o SELECT BLUE SKY IMAGE>SLECT THE BLUE SKY WITH ABOVE 
METHOD OR JUST USE RECTANGULAR MARQUEE TOOL>CMD 
C  

o SELECT THE GREY SKY IMAGE WITH ACTIVE SKY 
SELECTION>EDIT>PASTE INTO SELECTION>MOVE SKY TO 
APPROPRIATE POSITION>CMD D (TO DESELECT SELECTION) 

 
• BLACK AND WHITE 

o SEVERAL WAYS IN FULL EDIT 
§ MENU>IMAGE>MODE>GREYSCALE 
§ MENU>ENHANCE>CONVERT TO BLACK AND 

WHITE>ADJUST SLIDERS 
§ MENU>ENHANCE>ADJUST COLOR>ADJUST 

HUE/SATURATION>MOVE SATURATION SLIDER ALL 
THE WAY TO THE LEFT>ADJUST 
LIGHTING>SHADOWS/HIGHLIGHTS>ADJUST SLIDERS 

o MY FAVORITE METHOD 
§ QUICK EDIT>SATURATION SLIDER TO THE 

LEFT>ADJUST LIGHTING SLIDERS 
 

• CAMERA RAW 
o ADVANTAGE OF SHOOTING RAW IS PRIMARILY THE 

INCREASED FLEXIBILITY WITH LARGER DYNAMIC RANGE 
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o EDITS IN CAMERA RAW ARE NON-DESTRUCTIVE 
§ THE EDITS ARE GLOBAL, NOT SELECTIVE 
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KEYBOARD SHORTCUTS FOR PHOTOSHOP ELEMENTS 9 MAC  
in the EDIT MODE 

Thomas Grollman 
(The following is a small list of the some of the ones I have personally found useful.) 

 
        
TOOLBAR SELECTIONS 
 
Selection Tools 
Crop/Recompose    C     
Lasso      L     
Marquee     M     
Move      V     
Magic Wand     W     
Quick Selection Tool    A     
Type      T     
 
Paint Tools 
Brush      B     
Clone Stamp     S     
Gradient     G     
Red Eye Brush    Y     
Spot Healing Brush     J     
 
Other Tools 
Default black&white    D     
Swap black&white    X     
Eyedropper     I     
Hand      H /(spacebar)    
Precise pointer     Caps lock    
 
FILE SHORTCUTS 
 
New file     cmd N     
Open      cmd O     
Print      cmd P     
 
VIEW SHORTCUTS 
 
Hand tool toggle    spacebar    
Show full image    cmd 0 (zero)    
Show image 100%    cmd opt 0 (zero)/double click Zoom tool 
Zoom in     cmd spacebar (cmd opt +)  
Zoom out     cmd opt spacebar (cmd opt -)  
Zoom selected area    Drag Zoom tool   
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SELECTION / MOVE SHORTCUTS 
 
All canvas select    cmd A     
Add to selection    shift drag    
Subtract from selection   opt drag    
Deselect selection    cmd D     
Feather selection    cmd opt D    
Hide selection toggle    cmd H     
Inverse selection    cmd I     
 
PAINT / EDIT SHORTCUTS 
 
Apply last filter    cmd F     
Brush size     inc size ]    dec size [   
Fill dialogue box    shift backspace   
Fill with background    cmd delete    
Fill with foreground    opt delete    
Paint straight line    click then shift click   
 
LAYER SHORTCUTS 
 
Create layer via copy    cmd J     
Create new merged visible   claw E *    
Create clipping mask    cmd G     
Merge down     cmd E     
Merge visible     cmd shift E    
 
TRANSFORMATION SHORTCUTS 
 
Free transform     cmd T     
Cancel transformation    Esc     
Enter transformation    return, enter, or click move tool   
Scale proportionately    shift drag    
Scale prop from center   shift opt drag    
Transformation menu    ctrl click in box   
 
TONAL ADJUSTMENTS SHORTCUTS 
 
Smart Fix     cmd opt M    
Hue/saturation     cmd U     
Invert      cmd I     
Levels      cmd L     
 
 
*Claw:  MAC = cmd opt shift (“claw” is my own shorthand) 



MacMania 11, Feb. 6, 2011 
Seminar: PHOTOSHOP ELEMENTS 9.0 MADE SIMPLE 
Instructor: Dr. Tom Grollman 
 
OBJECTIVES: 

- The course is designed for digital photographers with the basic goal of 
learning how to maximize enhancement of your photos with Adobe 
Photoshop Elements 9.0. 

- The presentation will focus on the image editing capabilities of 
Photoshop Elements 9.0. Attendees should come away with the basic 
knowledge on using Photoshop Elements immediately in the intuitive 
GUIDED and QUICK FIX modes, along with a start in the FULL 
EDIT mode. This knowledge is to include photo enhancement: 
cropping, straightening, tonal and color correction, sharpening, 
aligning group shots, making panoramas, converting to black and 
white, plus other photo improvements. 

 
WHAT TO BRING: 

Your Mac laptop or pencil and paper to take notes. 
It is recommended to download a free trial of Photoshop Elements 9 from 
Adobe.com before the cruise or buy the program from one of many 
sources. 
For the free 30 day trial download go to:  
https://www.adobe.com/cfusion/tdrc/index.cfm?product=photoshop%5Fel
ements&loc=en%5Fus 

 
PREREQUISITES: 

Preferable to have basic computer skills (i.e. select and click with a 
mouse) 
 

AGENDA: 
 Session #1: 90 minutes 
   Introduction, course objectives, PowerPoint presentation. 
  Tour of Photoshop Elements interface. 
  Intro to GUIDED EDIT 
  Intro to QUICK FIX EDIT 
 Session #2: 90 minutes  

Intro to FULL EDIT 
 
 HANDOUT MATERIALS: 
  Extensive notes recapping the presentation 
  Keyboard Shortcuts list 
  Copy of PowerPoint presentation slides 
  Course description and objectives 
   

 


